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Supplementary Information 

 

Supporting Links 

Source code of SPCal: https://github.com/djdt/spcal 

SPCal executable file: https://github.com/djdt/spcal/releases/latest 

 

Tutorial – Analysis of Au NPs 

This tutorial demonstrates the operation and functions of the developed software “SPCal” by analysis of 

a 15 nm Au NP dispersion using a 50 nm Au particle reference. To start, download the executable file 

and example data. Users on an operating system other than Windows 10 will have to install Python, 

download the SPCal source code and install it as a local package. Data for a 15 nm Au NP and a 50 nm 

Au NP is provided, and the following experimental parameters were used: the uptake rate was 0.094 

ml/min, the dwell time was 100 µs and the response of an ionic standard was 17.4 counts/(μg/L). The 

transport efficiency was determined to be 0.062 and can be used to compare the “Manual Input” and 

“Reference Particle” calibration methods. 

The SPCal GUI is separated into four tabs: “Options”, “Sample”, “Reference” and “Results”, each 

representing a step in an analysis. Inputs have tooltips that describe their purpose when hovered with 

the mouse. 

Options tab 
Upon opening, the Options tab is displayed, as shown in Figure S1. Here users can enter experimental 

and processing parameters. Required parameters for the currently selected method of determining the 

transport efficiency are highlighted in red, parameters in yellow provide additional results when filled. 

 

Figure S 1. The Options tab. Experimental parameters (A) – (D), the calibration pathway (E), filtering options (F) – 
(I) and single cell specific options (J) are detailed in the Options Reference. 

1. Select the calibration pathway (E). 
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a. In this example, data from a 50 nm Au reference particle is available. Select the 

“Reference Particle” transport efficiency method. 

2. Input the experimental parameters (A) – (D) required for the chosen calibration pathway. 

a. The “Reference Particle” requires prior knowledge of options (A), (B) and (C). Input the 

uptake (A) and the response (C). As the sample data contains acquisition event times 

the dwell time (B) will be calculated upon sample load and does not require input. 

3. Input filtering options and parameters (F) – (J). 

a. The low background requires a Poisson filter. Select “Poisson” or “Automatic” as LOD 

method (G). 

b. The Gaussian and Poisson thresholds can be edited by modifying (H) and (I). The 

default values of 0.5, and 5.0 should suffice for most analyses. 

c. For samples with varying ionic backgrounds, such as those encountered when 

performing SP LA-ICP-MS, use of a rolling filter is suggested. To use a rolling filter, 

ensure the ‘Use window’ option is selected and input the desired window size (F). A 

larger window will be less affected by individual NP signals. 

Options tab reference 
(A) Sample and reference uptake rate. 

(B) Quadrupole dwell time. Can be automatically calculated if sample data contains a column of 

event times.  

(C) Response of an ionic standard of the targeted isotope. 

(D) Transport efficiency value. 

(E) Method of calculating. 

a. Manual Input: manual input of the value. 

b. Reference Particle: requires knowledge of (B), (C), (D) and the analysis of a particle 

with known diameter, density, and mass fraction. 

c. Mass Response: requires knowledge of (C) and the analysis of a particle with known 

diameter, density, and mass fraction.  

(F) Window size and selection. If selected, calculation of the mean or median signal is localised to 

the input size using a rolling window. 

(G) Method of determining the LOD for filtering. 

a. Automatic: Poisson filter for signals with a mean below 10 counts, otherwise Gaussian. 

b. Highest: selects filter with highest threshold 

c. Gaussian: (J) signal standard deviations above the signal mean 

d. Gaussian median: (J) signal standard deviations above the signal median 

e. Poisson: see paper for details 

(H) Correction term for Poisson filters, used for signal counts below 5 or when forced 

(I) For Gaussian filters, the number of standard deviations above the mean 

(J) Hypothesised cell diameter for SC analysis, enables calculation of intracellular concentrations. 
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Sample tab 
The Sample tab is where the user loads sample data and inputs sample parameters. Once loaded the 

individual intensities are displayed in an editable table and chart.  

 

Figure S 2. The Sample tab. Signals are shown in a table (A) and plotted (K). Details for the sample parameters (D) 
– (G), outputs (H) – (J) and controls (B), (C), (L) are available in the Sample Reference. 

1. Load the sample data using Open File (C) or via drag & drop. 

a. Upon load, data is displayed in an editable table (A) and chart (K) for inspection. 

Detections are highlighted on the chart in red and the mean signal (µb), and limits of 

criticality and detection (Lc and Ld) shown as green and blue lines. Use the mouse to 

zoom in on signals and navigate the chart. 

b. Ensure that the correct unit (B) is selected! 

c. The trim control (L) can be used to remove the start or end of an analysis. 

2. Enter the sample parameters (D) – (G). 

a. Entering ‘Au’ in the formula input (D) will automatically fill out the particle density (E), 

molar mass (F) and molar fraction (G) for a gold particle. 

b. If the particle formula is not known or not available in the formula input, then it can be 

entered manually. 

c. For calibration, the particle density (E) and mass fraction (F) must be input. 

 

Sample tab reference 
(A) Table of intensities. Values can be edited to remove artifacts. 

(B) Intensity units.  

(C) Opens a file selection dialog to load sample data. 

(D) Chemical formula of the particle automatically fills (E), (F) and (G). 

(E) Particle density. 

(F) Particle molar mass. 

(G) Ratio of the mass of the analyte over the mass of the particle. 

(H) Displays the total number of detected particles. 

(I) Displays the background signal in counts. 

(J) Displays the LOD in count and LOD method. 

(K) Chart displaying the signal in black and detections in red. The signal mean (µb), limit of criticality 

(Lc) and limit of detection (Ld) are shown as red, green and blue lines. 

(L) Trim, used to discard data from the beginning or end of an analysis. 
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Reference tab 
The Reference tab is only available if the user selects “Reference Particle” or “Mass Response” in the 

Options tab. This tab functions similarly to the Sample tab, loading and displaying data. 

 

Figure S 3. The Reference tab. Signals are shown in a table (A) and plotted (N). Details for the reference parameters 
(D) – (H), outputs (I) – (M) and controls (B), (C), (O) are available in the Reference tab reference. 

1. Load in reference data using Open File (C) or via drag & drop. 

a. Upon load, data is displayed in an editable table (A) and chart (N) for inspection. 

Detections are highlighted on the chart in red and the mean signal (µb), and limits of 

criticality and detection (Lc and Ld) shown as red, green and blue lines. Use the mouse 

to zoom in on signals and navigate the chart. 

b. The trim control (O) can be used to remove the start or end of an analysis. 

2. Enter the sample parameters (E) – (H). 

a. Entering ‘Au’ in the formula input (F) will automatically fill out the particle density (G) 

and mass fraction (H) for a gold particle. 

b. If the particle formula is not known or not available in the formula input, then it can be 

entered manually. 

c. The particle diameter (E), density (G) and mass fraction (H) are required. The mass 

concentration (D) of the reference solution may be entered as alternative way to 

calculate transport efficiency. 

Reference tab reference 
(A) Table of intensities.  

(B) Intensity units. Data in CPS is converted to counts using the dwell time. 

(C) Opens a file selection dialog to load reference data. 

(D) Mass concentration of the reference. 

(E) Diameter of the reference particle. 

(F) Chemical formula of the particle automatically fills (G) and (H). 

(G) Particle density. 

(H) Ratio of the mass of the analyte over the mass of the particle. 

(I) Displays the total number of detected particles. 

(J) Displays the background signal in counts. 

(K) Displays the LOD in counts and LOD method. 

(L) Displays the calculated transport efficiency. 

(M) Displays the calculated mass response. 

(N) Chart displaying the signal in black, detection in red. The signal mean (µb), limit of criticality (Lc) 

and limit of detection (Ld) are shown as red, green and blue lines. 

(O) Trim selection, used to trim data from the beginning or end of an analysis. 
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Results tab 
This tab displays the results of the filtering, calibration and statistical analysis.  

 

Figure S 4. The Results tab. Processed results are displayed in a table (A), histogram (K) and outputs (D) – (J). 
The displayed results can be selected (B), fit to a distribution (M) and then exported as a CSV (C) or image (L). 
Outputs are detailed in the Results Reference. 

1. Review the results. 

a. Select the desired results to display using (B) and optionally fit a distribution using (M). 

b. Results from the current mode are displayed in a table (A) and histogram (K). The fit, 

mean, median and LOD(s) are displayed on the histogram as orange, red, blue and 

green lines. Use the mouse to shift and zoom into regions of the histogram. 

2. Export results to CSV (C). 

a. Exported results contain all available method details, individually calibrated NP data, 

concentrations, LODs mean / median values as well as signals, masses, sizes and 

concentrations for each detection. 

Results tab reference 
(A) Table of result values. 

(B) Mode selection. 

a. Signal: displays signal data and histogram. 

b. Mass: mass data and histogram, requires calibration 

c. Size: size data and histogram, requires calibration. 

d. Conc.: intracellular concentration, requires calibration, cell diameter and sample molar 

mass. 

(C) Opens a file dialog to export results as a CSV. 

(D) Number of particle detections with standard deviation. 

(E) Particle number concentration per volume, requires calibration. 

(F) Particle mass concentration, requires calibration. 

(G) Ionic background, requires calibration. 

(H) Mean value of selected result. 

(I) Median value of select result. 

(J) LOD (or mean LOD if windowed filter is used) of selected result. 

(K) Histogram of results. The mean, median and LOD(s) are shown as red, blue and green lines. If 

a distribution is fit to the data, it is shown in orange with the maximum value highlighted. The 

mouse can be used to reveal histogram values and zoom in on specific regions of the histogram. 

(L) Opens a dialog to save the results histogram as a PNG. 

(M) Selects a distribution to fit to the results histogram.  
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Batch Export 
Once a sample file has been successfully analysed the same parameters can be applied to multiple files 

using the batch dialog. The dialog can be found in “File → Batch Dialog”.  

 

Figure S 5. The batch processing dialog. 

1. Open sample files using the Open Files button (A). 

a. Open files are displayed in the file list (B). 

2. Input output file parameters (C) – (F). 

a. The default parameters will save a result CSV with “_result.csv” appended to the path 

of each input file. 

b. Trim will be the same length (in seconds) as the current Sample tab values.  

3. Start the batch process (G). 

Batch dialog reference 
(A) Opens a dialog for selecting file(s). 

(B) The list of currently opened files for batch process. 

(C) The name of the output results. A ‘%’ denotes the current file name and must be included. 

(D) Directory for output, if blank the same directory as input files is used. 

(E) Opens a dialog for selecting the output directory. 

(F) Selects whether to use the same left / right trim (is seconds) as the current file in the Sample 

tab. 

(G) Starts the batch process. 

 


